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Learn in English

Snagit is a screenshot program that captures photos, video and audio. It is created and
distributed by TechSmith, and was first launched in 1990.
The Snagit Editor is a basic image editing program which comes with Snagit. It can be
used to make simple changes to screenshots, including adding arrows, blurring sections,

or cropping.

sz wbojly
Capture S, pL’ (Sl p S
Convert Images 23k s
Custom sl
Editor Sl
Image BX o]
Options ol
Quick Access B s
Related Task Loy o (sl )8) il
Settings Oledsy
Text &
Typical Jsere *@.‘J
Video ok

\Y

www.DataNiyaz.com




oT‘L.;ug;:’.L:.J) Snagit)l;&lrjwas‘;bl}::djl&a&

£ gl 505 © smime Capturing la, 3105 e5o 25513005 r\.»S =)

Camtasia (>  Photoshop (C Captivate (o Snagit (<l

Sl o s> Snagit 513105 L K g 5l 2, 50 RAM il Jilas Y

#MB (5 VGB (- 0\YMB (o YOFMB (I

Sl 5l 0550 2l ) JB slidd e 4> Snagit )13l 5 i 51, Y
\YAMB (s 0-°-MB (C #°MB (o YOFMB (i

S5 g0 0D ste BB 5o 03 Sl | sear Slay «Capture > o 1S ¥
Image Capture (o Text Capture (&

Web Capture (s Video Capture (C

83,0155, 515315 Jams (55l a5 6510 5 ohd 51 «Capture b oS 0
Image Capture (o Text Capture (4

Web Capture (> Video Capture (C

85,15 5 52 5 Snagit 1531 51 i r\JS 3 Capture sau Cis 8 i 5l bl _f
Related Tasks (& Profile Settings (<l

Profiles (> Quick Launch (C

03 g slitanl 1ot ol s 51 0l a5 H10S 512V

Snagit Editor (& Convert Images (!

Related Tasks (s Organize Images (C

\Y

www.DataNiyaz.com



I ad 5 1,8

g pU |, Capturing 5131s 5 dio S Capture ;! , glate
£,05 2l 4> Snagit ,131s 5 Y

ene 3 |y Snagit asl ; cuas Cga 5l 3 g0 SUSG! J3las Y
e g 1 S5 20,6 5 Snagit 515315 Juol slacens ¥
B D § 5 Snagit)\p\rj' s Capture Cilises o)l _0

- ) ne (55, |, Snagit 10)\}\(1)_\

el g 1 o s il (Sloind 503503 Ll 115 =

\¥

www.DataNiyaz.com



Snagitjl)ﬂrj.hujlmaged.,p . rjﬁ J*ﬂﬁ

o) ciliee s> , Image O, g0t Capture UJ;

o) g

248 gy T g2 s 51 Juad ol aalllas 51

Sl 1 ol Sladss 5 (65l S s o, -

s a5 1S 208 seny ob 1 Input 6 5 s s p 15! -
&y \)5\&)aj)lS)Output‘_g};.).»LuJ?}}t\,;\_

&S sl skl s, 1 Effects (6 g 5o cilise (sbs gl &1 52 -
23,5534 |, Profile Cunsd 55 5513 oS 6 5 -

.aS s p>3 Profile & LG s \)Image»):&é;rlqdlok#ﬁ“x\}:{-

\0

www.DataNiyaz.com



PR
ol amieo 51 5ls WS Snagit 5115 ol G B 5 S s oLl S b ol
Sz ol 5o ‘Snagitkwhg&uij)lﬁlrjwj\w - aily s (Image O, seos Capturing)
G bogle Jaslogomi 5 s> 5 5255 Olaksd ((als amis 51 WS 38 S il sl |

i Ll sl
ool amio | w&oﬁﬁdajjlfola)thal Y-\
318 S 5l bl g

¢ &y yos Ll Profile Settings

| l{d)})) (Cnannd L')'»‘)‘) :Input.
,::;@UMCapture 83 3ua
Gl 13 Gyt 51 & 5500 0 et

&}gd\j.(T_\JiJ)ogjfww&

i iﬁm (Fullscreen)mrw@.&;.\:s |5
Hm{:rrE: T — VA P
: Properties...
$303 bl ¥\ S
T3 tione =3 G o] : Output @
"": e A8 o ot |, Capturing Sldkes
[ Chipbosmd
i B 3 ohd el S8 453 gk g0 et 5
"F.LP |h~?‘£hﬁ|J&))”w‘.}wlﬂ)bé‘(_f‘o‘-\s
= Progam | oS sl g o 4 g5 5 - (YY
I Bl
i~ word .\:.:SJLM)\ExcelL_Word)l}\rJ;@
7 Soreencast. o N,
E;_ “m -ab3 yiwlel Snagit Editor ;5L
[ prome setins= [N
| utipe Outpus 5 el _Y_Y JKa
N T
M e {::;rr | Rrooartie

Www.DataNiyaz.com




0 Image &, sou Capture o 8 L1y r,:dﬁaé

CJ“'LSJJ \)@‘}’JJ&L&&},\?}.&S&)W ‘)bwﬁéw&#‘j@ww\)) : Effects ®
5 s 3y e Bl 4l Jagl Ly yu 03151 skt A8l 18 505 5, (¥ JSD) S e

Edge Effects ’
P stermari..
Jrim_

o gl YV s

-l o Capture Clls 5 o gl ¢ 5 & 153555 Joli 5, S 2 Profile ®
Capture Oldas sl Jo 0 Y_¥

s ol |y 5 ol e i 316510 oS 51,

Solap oS sl 5 )50 Oladdiis 5 o g (25 3 0625)5 D3] )

(Print Screen aJS (s s L) Capture aSs 55, SUS 5 Image as Sls| Y
Snagit Editor ;s (3L &y g ,3) b 4 § yslear il 55—

)EJJ)}df}fﬁb'\&bleq‘&u&jlu)”{oks_f

Snagit )l 31p 5 )2 635,585 L bl Y

S sl o o5 oy, sl Snagit)\)élrj JInput Cwud s (Profile Settings iz s
Image ¢, |, Capture s 555 s | 5 b & 48 S5 i 5t o 56,20 il in L) 5
sl 8

\Y

www.DataNiyaz.com




(Y=Y JS) 5 et o ufuﬂb i 5] WS S uua_fa\gl;',.ﬁ\ L : FullScreen ®

TR
3| mewel

- = I e

it amio S 1 Se o FY—F JSa

ol (e s 55 3L gl 2 51 (S gs, SUS L sl g e an ol Slesl | : Window @

(Y20 JS0) asS ag oSe

-
e = |
| il emedm b B [
g | X o
4 Lz "
Ee LT -
pg—

o s 51 e 38 § Y0 U5

b ez ol 51 Input 6 s 51 Advanced s 3 45 5 ol Ol L : Active Window @

VA

www.DataNiyaz.com




0 Image &, sou Capture o 8 L1y r,:dﬁaé

5 S buslye ¥ ol Sl Snagit 13l 5 55 308 sy S 51 S - Region @
&y ailg g au S el 51 (YoF JSG) acS 4 oS il ambo 1ol yids 03101 | (513 s
.\ﬁl.u@.)\ﬂ*ﬂ‘ﬂw)bu}b)‘ Y‘S;U’"J;

o) 35 53 ydonn 1 WSKe  S Y8 IS

9 4254._

Giales i 4ol s 51 ol b (3§ WS oISl dnput g s 5> Multiple Area ay S Gl |

G:)Lclﬂ-; ‘\A:L> d\j Ju}w‘;e °§AJ @‘:&:‘ L;Lhu“’“ twl.u Wd}) QJ; QS/).)L .J)‘.) 929
(Y=Y JS) a8 Ol | Finish S 500 S ol y SUS amis (55, «Capture

aob s ) WS 3 S Y IS

V4

www.DataNiyaz.com



ol o311 b slamb o151 3 Input s s 3| Advanced (s s 5 55 4 S oyl : Fixed Region @

(YA JS2) 05 s e oS sl domis |

Sl 83 o ) S o8 S YA IS

—0 A o—
S 53 56530 Ozl |, Properties 4 8 JInput g gie 53 1 55 g0 03151 a1

1) 5y 90 00 9d5s t\.&;,\ Height Cwus s 5 L Width cwws 5 (Fixed Region
(YA S) asS et S o

[ ingut Prcpries ===

Scmwars and Comarns | Bstended Wesdoes | (Linis | solspaty
il [P P i Bargiing

[T T ————

- 'E I l.l _I_- Jf_Jl!:{.-_'rll}“-‘ih'ﬁ'

b 18 s
mmmm4bﬁbﬁ“?w ]

[ ox | come -

Capture 53 e Olodis Y4 S

www.DataNiyaz.com




0 Image &, sou Capture o 8 L1y (”"J“é

dio 33 g2 g0 ol 31 15 e Input (5 s 51 (Advanced Cuand 55 4x S ol oy : Object @

(YD) e JS) S 4 oS 5l )5 sl s oy G il sl 5 oSl e

o e —
§ s

FR T

Wil e o8 S =Y S

A

www.DataNiyaz.com



YA F RN PERUNNES NP e:) iR AP TSTE A A CH PR WO R L
Cranedd 34l s &,Q\J}a,EnableDelayedA;.lJ'fgli..:sl)(Y_\ ¥ JS&) Options caend ;> Timer

'J‘iL“)lf \)ﬁ))}ﬁd}db@.}j}gﬂ‘)&a&ﬁu\é‘};@ s("_\"dg.w)b-\m)le).)lSJJDelay

— a8 o—

Capture

bone Scabe a
Gdecind 400 [

| Al ahe S e A

v Lise wher you nesed i b i sef L @ CapEUre, Bach
| HjﬂpJnh'lmn'MH.
Deley (peconds: 10 2

¥ sl » 2 e vl ol
Scheculed caphre e Loy ot

| o [ -

Timer Slodss YV S e
e A o

48 Input ¢ s 31 S 4 WSe 5 oa3h S sra ) 5l el S oMo sl yiu S

Capture cascade menus 4y 5 (Menu S, w5 b 45 s 5 aulei S| |, Properties

Y2V E ) S sl 1

Yy

www.DataNiyaz.com



0 Image O yo4 Captureo;s;‘_dbl,::r,aJ.A

Blomtes s ‘

[ [ T -

o iy YV F IS

W_S_}lu:ﬁuﬂd\w&&mﬁ;ﬁ)\.\g\j@ &5 ol 3l eolizl | : Serolling Window @
QSJGJM)Q;&‘QW')‘W J.:SA:@JU‘SL tML@WwLyh)LyoML‘md‘j)wy
Cay SIS 558 o A T GIbI s SlbasSs ot e glbcans g5, S > | (Capture

IS o 1y ams (YN0 JSKG) a8 et ) S 59 0 Gialen b 581060 508 iilaw il 50 o S 2
Aa‘so.\b\mu Y_\?¢

AL RN R T
P T

(Lot ST T SR

Bl 1

== 0 LIt

(o o] [opasl

Yy Wu&bﬁb‘,’uul’w‘_"_\o‘}&)

www.DataNiyaz.com




5l 8lo,le &)ls 5 95 5 Input (6 5 50 Advanced s ;0 & ciley s> Lo

©o308 Liabew 15 ol Jld 5 o 51 555 pbay 4y § oyl lis! L : Seroll Active Window @
3 g e S

(o908 Lialew 15 syl s i 5| WSe o5 8 oSl iay § oyl Law s ¢ Scrolling Region @
FPIEEYEPIE S5 5 SE L D O g4

S5 8 Jy s S o pem 55 sba Llew bl osgams (s oyl 5o - Custom Scroll @

..guubqu@uao)ngp}jﬁhbdjbjw&;u,mdt@

L

L ]
ey Nl

PN

Serolling <> b sz ) o&Ke o 5 Y\ JSa

oS! ‘J,J@g_;&;:\ub;uzﬁ)}bq}awéh'p\)\}\rj\oM@é@fcx\:AH—in—oneo

e 2 a1 palag o 2 Loty b S5 S (8
593 SIS sl ) B3 o 5315 5y 59 gl st S, sl 512 e Sy i 0
VY S) 0,8 013 08 Sl o g el 38 il om0 3 S -8 Sl ol Cnnt
le oo ey il (g1 (6 sle o sl atls &0t gdla 0 2w Lo s ) 32 ) il 0
035 e 31 s gt 0 2 631 S S 3305 A S o 01 31 0l 5 15,15
T2V ) a8 SIS ol ol g 3 0t pll gl (soasS's (6550 2y sload 4 sl oLl

e Bl sy S e 2t gt 55 ) ol S ool rals K3 2l g cnl posdle
vy

www.DataNiyaz.com




—e Imagec;),.quaptureQ;s;&lsl,::r,.)J.ai

Y0 All —in—One sy 5 s 2 gl 2) O] —Y—VA S

www.DataNiyaz.com




&) Capture Oldas 1, o )lga 03 goous 3l osliial Gl 4 a5 5 i ol ol : Shapes @
4l gl \,@\ﬂ;J&J‘QJ;gf);L‘g\ﬂ;.wao)}a@ sl g g > oyl 5o : FreeHand o
(Y2 ) J.,'wa) Capture

3151 s &y oty g1 5 WSe YV S

I i 3ty 51 K Y Y S

Y#

www.DataNiyaz.com




@ Image &y puoks Captureo;s;‘_dlsl,::r,aM

.;),T@ 9 a}f sbas S\ Jdeias S &) oo | Capture o5 sdows ‘u}f ¢! : Rounded Rectangle o

3 b o g el donios 1 S e S 4§yl G L : Triangle o

‘_g‘j\)W&d‘o))W)AMMwLU&sde)&g)S)l{,bl{s&})a‘)J:POIngH (o]

—e

< 5 4 Capture 4>l ‘wjajfduu;\u}fbgw‘@’aﬁrﬂ)r@Shiftww\;&wlﬁL

.J\;Sdaaleq\d)bjw&c
s

33 g MY (6 slota e 55 8 bt SL o o2l 4 s

—

(@jw&)w’d‘j .)}JL;‘ DML;}A @jw u.;wv\ L;'Ju.b)\.?}_aé ‘Capture DJ)WASQ;JL‘»)J
K, «Canvas Color cuns s «General S, w55 553 5 Olnsl |, Properties 4 S JInput (s s s

(YT JS) 5 s pr Lt a3 u «Transparency s Ol b LS Ol 1) ks ) 50

A5 o

| e ) py 8y i

A oy g Y
Qe 0 e Jy

[ ao uys Jy oo

Yv

merss | Extencedvindom | Leks romoos |
. N

General
Geraral cpbena
The camvas 3 Bhe area oulsde T Lacere,

Clghoard est gl 540 = pesels
Windge caphee bie bar Tanansrency
@ Chean e bar

. [ravsganent e b
gl oo bat

|| Canced | Ay

Capture & j w Sleplzs YY) S

www.DataNiyaz.com




.byflbd\a_;j“t.u).\mb.\\.\c:.«ﬂjd-jdlbwjajuj)d“’\«ﬂ‘ J)\}A : Advanced‘_;l.b@fxl..a.
Graphic)  , g5 b6 ((Clipboard) . ge alasl> (| siea 31 oS ags disle cdiisly o ais iy o655
3 Sl 5 (DirectX) b5k «(Fullscreen DOS) DOS L. «(Program File) z!,>1 J6 «(File

.(Scanners & Cameras) Jlxows s 50

Snagit )l 3ls 5 2 b2y 5 ¢l L bl YF
o 5o (Y2YY S0 aS bl | Output‘\;ij‘f Profile Setting _ix 3|« 5> sl s,

ol ods oals @ﬁj%dl&f}f i

_lﬂ Hone

i Brnter
L] Clipboard
il Edle

i Screencast.com

i3 PowerPaint
S e
- o Ecitor
Soncied | __ Properties..

YA

www.DataNiyaz.com



Image &, yoi Capture s S by £ i

Snagltjlﬁlr,. L Lﬁ}f t‘y‘_“_\ d}-\?

Ol 55 TR
o ol e None
Kl x| Printer
g dlail> 4 | Clipboard
b Sea Sl File
S S g b 51 b E-mail
cale S ool 4 Jlay| FTP
S8 sl 4 Ll Program

Office 4c yazs sl , 4 o, | Word, Excel, Powerpoint
'Screencast.com Cylw 4 Jlu | Screencast.com

Camtasia 4l , 4 b, Camtasia studio

WY
&l 4 & Preview in Editor 4y S «Snagit Editor s sy s sdet 45 5 5 saar il i sddlin ¢, 0

S Ol |y Canl Jlad o 3 i

Juol i o o dim b 0o 00 O ot \)b.ua.éjfjras.\g\,:@ Multiple Outputs & 5 Slsl Lo
&> Snagit Bditor gas 3 51 e Sl ) 53 .S Sy 55 Word Jamwe & | s guas sl o506 dita 1S
S S ol Gla s o plevt S sl 8120050 15 5o Fimish a8

(Effects) Ws g | ‘_;“aui Y0

oo gl 5o 2 usly s il 4 § 15 Profile Settings i 31 Effects gy 3 & glaay § bow s

&)@M'MLA¢J¢.§JL&\9M&3J§JULASQS))J:\)WL"-

w13 0l kil s Sy Lo AT g1 1 glaad  Tech Smith < 4 Jaw 5 Cale e -

Y4

www.DataNiyaz.com



—e S5 0—
JG 5 «Capture (s s Filter (s s 5 5| Profile Settings s 5 Effects Caand 5 05 o gl

. s 03\

Color Depth ¢ g 5 Y0
&l 30 Lyt o 5 gr o sk pl S8 4 3 put o 03lital yslar Ky Gas e S50 0
L;lbd.g’;tb .b_yf&‘.’ux.pj (Y_YY‘ Jg.u/) ;yaJM\@»)\M;&G{)Ql&Nb\ ajaé-.')

ol st 0315 Ui YYF S 3 W gl ol 6,158 515556 5 Y=Y Jya 45 Color Depth

Loler Depth Hone
Color Substitution Menochrome...
Cglor Comection_.. Hs¥tone
Image Besolution... Grayrcale
| mage Scaling ¥ . Custom Coler Depih...
B
r Eorder...
Effects L
m = i Color Depth g s 5 —Y—Y¥ |
T

Color Depth s s> ¢ ,138 51 o o5 —Y_¥F |

www.DataNiyaz.com




@ Image &) g0t Captureo:.i;&hl): 3 (’”J“j

Color Depth 6h¢g}§_Y_Y J s
Sl s

.3”1@)3&)&@)}@9 )y Monochrome

S o i Koy 6 S b 5l oy poty | 5o Halftone
A8 o s S S Cab b s ol O ot | 9 Grayscale
.(Y_wa)»:@j)gq\)&:JLQ)}.‘;@&)&;MQK‘\ Custom

)})@jYLU‘P»)ﬁjra:w;xw\a}:wb&)a‘wkﬁ

Comc T

| -
TIT P i [l =

| Lo i

1 WA Craw -

I

|

ﬁ - I:'.. =l L

Jas — _— - —— -

K Ges sy _Y_Y0 S
W <)

.J.,;fgg&s\\)NonleAbxf‘_;,uj)’): oo gl 31 s S ke e gl

Color Substitution ¢gw 5 ¥—0_Y

Jdnvert Color 48 (Y=Y F [S2) 5 g go oolitee] » gui 53 352 30 G, o il g1 05k
(Y=YA JS) b, o Rl (1, Color Substitution 4y § 5 (Y=Y JS) b, 03 5 sSan s,
&g g0 0ol

A

www.DataNiyaz.com




Color Depth b

Coler Substitution ¥ HNone

Color Comection... Invert Colors

Image Besclution... Color Substitution...
jmage Scaling b

Color Substitution (s s » j —Y—Y# |

255 G0 S5, Sile Y YA U

vy

www.DataNiyaz.com




e Image & yo4 Captureo::’;@lsl,: 3 T”"J“j

Color Correction ¢ g 5 ; Y—0_Y
gl Ol 5 30l 325 ( SOV e 2y Olme et 5 2500 S i 51 05 )
(25 S e a8 Y Joim 53 (Y28 JS) 55 gr ool 5t 53 352 50 5B,

el s ools il YYe S s e led p b blis jslear 5 oadd ool

e J— R

{

(o o] 3o Y 5 5lad) K ey iliun gloclo Yo (S
vy

www.DataNiyaz.com




Iy a5 08 @

Color Correction gy 5 —Y—Y J i

Sl 5 we 8 295 5
2@ glhds) Ol aw Brightness \f
238 52 b Sl 28 ol s Contrast ¥
258 Ky a2 3L K5 4 s Hue ¥
& DUl }\:» M) S Saturation I}
&h&,)ﬂa:u;w\\ij}a:&)obgw Gamma 2

Image Resolution A..ijf Y_o_¥

Sl 96 DPI 15,3 oy bt oo 3 3 sl 00l 5l 7 325 5 kS (8 51 0 gl a5
Y pane oo Sle y g b oS 3 5kt 31 oslitd 51y ol a5l 5 0o 5 Ll 51,
Jus & |, Auto Configure 4y S lul «  gaai Cds i gl 0 et g oolize] YU 4 400 DPI 45 )
(TP ) s

Image Respiunon =)

Lise mage resolution o ol how otfer aoplcaborn Seply
and prind Snagd mages.

|| Moter The does not affect bow Snagit deplays or prits images.

i ol | B PO
=)

Rescluiens 300  DPI(dots perinch )

e 3 s ¥ S
Image Scaling ¢ s » ; Y=0-0
2 b Al s s g 030t (o S L 2l S)3) 508 b 50518 el 51 425 a5
AYXY IS8l TN ooy plar s

vY

www.DataNiyaz.com




0 Image O yo4 Capture&:s;‘_d\sl,: g [-).)J..aé

[ S—— ;| pa—
{ pee: W 0w

peghe w8 W
a  ar

R
I e e ek

[ gprlpnio |

Image Scaling ¢bay ; L & LW

o || cowes |

Caption &y 8 Y—0—5
s (User name) ;8 rls «(Computer Name) 4|, rl: ((Caption Text) cpsbic Liales gl 408 ol 5l

. (Y-YY Jg.«/) .)}M‘-sﬂ AJLALw\Ji}aaS S (Tll'lle/ date) UL‘)J c_)b u.); P

Lunbom vaplen
o) T

Eapton funt

-

Faw cactr pussie gl s

Hpal e gt
T S ——— —
i nama

11 ‘!Eﬁ'ﬂﬂiﬁ "-;?ﬂl:ﬂ-ﬂ_ﬂw

P 5 TR
Printer culpul seilngs

o

Yo Caption sl _Y_tY JS

RE-MOBARHT admen B 10.41
A Brrarpdd

www.DataNiyaz.com




—o

-3 30 g0 0315 (il Snagit Editor >y & 55 5o plb bais Ol

03 J3 5 50 sl il st S| Print captions at the bottom of the page 4y 5 & i,y 5

lpos a5 )8 @

&S 00—

Border &y 5 Y—0_Y

(T¥ s 5 Y¥F S) 5 50 L] peai Gl bl 4y |y 8 S5 55 e s S gl oy

Barder woilings
d Bare boeget [uiiede oF male
I X e

Tovia vfins 'ﬂ

e
T

(#% ) e

() e
(o ) e B

Border &y § —Y_Y¥ JSu

Border cbay 5 —Y_F J ju>

Sl &5

o

Enable border

2545 51 52 Qb ools 1

Place border outside of Image

S A Oy g0 OB ol 3D effect
(s e ) S8 slig puns Total Width
b wlu sl s Shadow Width
Sl Lol X, Main Color
N Ko, K, Highlight Color
sl K, Shadow Color

www.DataNiyaz.com

\ikg



Image & 5 gt Capture 6 § sbly: £32 Sz

oo gl YO S 55 .05 gone diile a8 o low | e laad (g5, 1 gslite (Lo jlo S ]
.Ca.w‘c.&ic)))“'Y-OJ}J@)JQTDJL@JL‘ck}@@j.xﬁdb#wi)ud))aﬁdu\

o

ba s

J.;JLAJA.,JG_,) aMJk&‘duok_Y_vo‘}gJ

(Edge Effect) ad o go Y0 J 50>

Sy wf Ayl e
o 03 93 (slaald Torn Edge \
Ll s <ol Wave Edge Y
<oyl load Saw Edge v
Gl S olus sbad Sharktooth Edge ¥
s e (laal Fade Edge 0
A 5 slaad Beveled Edge ¢

(o w\nuiang@‘)-’ “;gu@@jl{))‘sﬁbduﬁj Drop Shadow Edge =

Yy

www.DataNiyaz.com



Watermark &35 Y—0_4
(YYF JS) aes Gl ool sl 655 15 5 o sSIL ()Lsﬁ sl g o % ol b5

Watermark 8 —Y_Y# S
Trim & 5§ Y—0_) -
slaal u,&g\&;:s\Automatic;JL»;\ .(Crop Jus) J}J@osu&«\jﬂdu%jujjd\j&i;d‘
(Custom s s (T JS) Sleir Sl pgu 350 D 5 i g i 35 LB sy

(Y2YA JSG) 5 500 patmaiue |y &6 u Gd geai BB 51L& oo Sy slaswi o] 5 o0

(Automatic) p pai bad Solboss| o =Y-FY Ko

YA

www.DataNiyaz.com



Image & 5 gt Capture 6 § sbly: £32 Sz

(Custom) o)y o 3] & _p ges gbad (o p =Y YA S

Options ¢y 5 Y5
3525 613 S 5 6,1, kb 4 by o Sledis (Profile Setting Lisu s> Options Cud o
1Y JS) 5l
* @ ( T- Options gbay S Y5 J s
= Sl 35 Y

ot 4 8 b b geai 55 usle o il Sals 1
Options dbxg;_Y_\"‘\ IS
Snagit Editor s s 5o Giles i s liee

g ol 03 5 Jlub
03 Sk 53 3y g Jlab SLoSid 51 S 8 5

4ol 5l ol o (S o8 5

WProfile L ,i5 s so0 YV
JS) atly o o gl 5 25 3 25,5 «Capture Sl Juli L5, S o Ll i oS sboles
b sl Lot cp osdle 05 5 5m s 03lal (gl b 5 wdam & o jians olSeel (Proofile s o (Y=Y o
Dby, S olse a1 555 Sladas Profile sz YU 53 (Save as New Profile) Bl 4sS s s 5, SIS

%S‘SASHA“SQLSJJ‘d)l’g}f‘b}jjéo\ﬁ*;gjw‘d\j (Y—f\d&u)}ﬁl&)bﬁbéb\)’h’)&l)&’d

Y4

www.DataNiyaz.com



Iy a5 08 @

Y

Mo e + Empart + Effects + Dutput

= Snagit profile

Snagit j3 U, 0 —Y—F° S

Prrolilies

Capture A
el — e o
— n — 1 — E
| sl ~ =
L]

&ll=in-Cire™ Full Screen Copy to clipboard  Web page as PDF
s e el Bk
Copy best to Firex: heared H-u"ru-nlrlhllm
chipbnar

Profile s o —Y—F\ JSs

Snagit ) 3 1s 5 Loe | s b S YA

575 A 81 -3 g s SO s 2 5o Capture S 553 L ]
ta ool 5 Jo e (Smagit 515315 51 S 085 5 158150 2k ok e S|
.S Ol 1, Program Preferences 4y 5 «Tools (¢ st 31—
Jus & |, Hide Snagit Before Capturing 4, % «Program Options <5 , w3 wodat 3k ;58 ;5 Y
S S Ok S5 (55, 5 (YFY JSt) 03
D135 heole oy 51 Capture asSs (65, SIS b iculin (20 5 550555 DBl 5w a5 0 Jl>
S 4 S ol sy
to

www.DataNiyaz.com




0 Image O yo4 Captureo;s;‘_dbl,::r,aJd

—e

E___.._ —
[ ]
[7] picde: Snagit befare capturng
o uigrafupr
[ Graw halp e
o e Eay g
[ Cose 1o tray
[ e 42 way Color scheme: (Back =
Erifer npbom.
o Mt Edb e e e o0 SRR
) My ke Bkt ryrvirsy i background | Fie Assooabors...
Ervasll AT
77 Pt g 8 WML Sor Dok Bapress
o B it v b momad [Sutiso Outioss Biress sy
| ResetConfigrason | | Cesragey |

] Coma ] [ s

Snagit | WS o 5 oledis _Y_FY IS

3550 3 (Hotkeys S, w )3 «Cawl Print Screen 55 i 5 sba S Capture sbe 1S i 1,
.S Ol (Global Capture Hotkey ix 5o |, ki

LI

A

www.DataNiyaz.com




I ad 5 1,8

<Ml o (Image o s Capuuing)u:gumj\djlgjw&s‘Snagit)\}lrjéw\dh;j)Sj\059"0
Sl 13 G a5 55l 0 et :gﬁ@uMCapturew}w L 25,5 dnput Cons > @
23 g Se

sod OBl 23 iy sba & sl Allinone 153105 Vo dond 53 53555 i gl 51 o @
s S a  pila o 2 oty b S5 S 8 5 0]

40l o108 4 ot g OSE 3 30 b e 3 0t s CapturingSldas 5 > (OUtPUL Cusns > @
2550 |

)\J‘.é\rj‘ 3 ol w; oSe (Options Cuws s b Input (¢ s 3 Preview in Editoranj‘f ol L e
-5 3 g0 0315 2l Snagit Editor

lids g A & a0l o Juos! ol Output (¢ s ;5> Multiple Outputs wl obsle
ey g 84,

Wil s S Jleel ol oy 1y 2 lsmds slos s 55 505 oyl [ bt dngs oS () 5o (Effects Cuas 5@
e LB 8 S s 5

(ol e e o Lo a3 133525 615 S 5 01 phed 4 b 3y o Dlarais Options cuas 53 @
4 o wnd Ol (Profile idw 53 . auily o Bo gl 5 255 «($35,5 «Capture > ol Loy, S @
3 (Save as New Profile) Bl 4S5 5, SIS L ol ggn cn 5osdle 350 5 5my oolel sl hlo s, ouam

g ool gy b co by, S ol 4 |y Image oledes (Profile s sy oY

fy

www.DataNiyaz.com



Learn in English

All-in-One Capture

0 Image &, sou Capture o 8 L1y r,ad.aé

The default profile in Snagit is All.in-One. The All.in-One input in Snagit allows you to

capture a region, window, or to scroll a window during capture. This combines the input

settings of Region, Window, and Scrolling Window.
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Learn in English

Snagit Editor

Use Snagit Editor to apply professional, quality finishing touches to your captures.

Also share or locate, view, and manage captures and multimedia files.

Editing options include flip, mirror, shear, rotate, crop, and cut. Adjust the color depth,

add text, or view the frames of a video capture.
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Learn in English

A Multimedia Application

A Multimedia Application is an Application which uses a collection of multiple media

sources e.g. text, graphics, images, sound/audio, animation and/or video.

A Producer: A producer is a person responsible for planning and coordinating the

development of all the different media in a project.
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Create a project starting with blank slides

You can start with a blank project, and then import slides or images from PowerPoint

presentations, images, or other Adobe Captivate projects.

1. Select File > New Project > Blank Project.

2. Select a preset size in the Select list, or specify a custom width and height for the project.

3. Click OK.
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Learn in English

Master Slides

Master slides define background and common objects such as logos, headers, and footers
for your slides. They provide a uniform appearance for your entire project. All the artefacts
on a master slide, such as, objects and placeholders reflect on the slide that is linked with the
master slide.

A group of master slides make up a theme. When you create a blank project or a project

from template, Adobe Captivate uses the default (Blank) theme.
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Learn in English

Record video demonstrations

1. Click Video Demo on the Welcome screen. Or, click File > Record New Video Demo.
The recording window, marked by a red box, and the recording options appear.

2. Click Screen Area or Application based on what you want to record.

3. Specify the options. Select a panning mode if you want the recording window to follow
your movements across the screen. If you are adding narration during recording, select the
type of audio input.

4. Click Record.

5. Press End when you have completed the recording.
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Learn in English

Assessment mode

Use the assessment mode when you want to test how well the user has understood a procedure .
You can set a score for every correct click. You can also set the number of times the user can
attempt a procedure. When the user fails to click the right option in the number of attempts
provided, the movie moves to the next step. The user does not get any score for the failed
attempt.

When recording slides in assessment mode, Adobe Captivate does the following:
® Adds click boxes at places where the user must click the mouse.

® Adds text entry boxes for user input. The failure caption is added to each text entry box.

aais aalin
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Attempt AN
Click Box 25 SIS dan
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Limit S g
Recording Lo
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Success Sk go
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Learn in English

Rollover Slidelet

In Adobe Captivate,arollover slidelet is a space on a slide that displays an associated slidelet
(a slide within a slide) when the mouse is moved over the space. You can insert and display
objects in the slidelet using the same procedure as that for the slides.

For example, you can create a rollover slidelet for a state on a map so that the demographics

of the state are displayed when the mouse moves over it.
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You can use the following options to define actions for interactive objects in Adobe Captivate:
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Provide if ... else conditions with and/or operators when scripting actions.

Standard Action

Use a single script to run multiple actions in a sequence. Although the user interface provides

a way to run multiple actions, it is restricted to the actions available in Adobe Captivate.
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Learn in English
Record audio for objects
You can record an audio file to use with buttons, highlight boxes, click boxes, or text entry
boxes. Recording audio requires some basic equipment.
You can also add existing audio to text entry boxes, captions, slides, slidelets, and so on.
1. Right—click the object to which you want to add audio, and select Audio —> Record to.
2. In the Object Audio dialog box, click the Record icon.
3. When you finish recording, click Stop Audio.
4. To listen to and test the audio file, click Play Audio.
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Learn in English

Timeline

The Timeline is a visual representation of the timing of all objects on a slide. The Timeline
provides an easy way to view, at a high level, all objects on a slide and their relationship to
each other.

With the Timeline, you can organize objects and precisely control the timing of objects. For
example, on a slide that contains a caption, an image, and a highlight box, you can display the
caption, then the image 4 seconds later, and then the highlight box 2 seconds after that. The
Timeline also shows any audio associated with the slide or with objects on the slide. You can

easily coordinate the timing of audio with the slide using the Timeline.
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Learn in English

Defining motion paths for objects

1. Right-click the object and select Effects.

2. Click add effect, select Motion Path, and then select the type of motion path you want to apply .
3. Click the symbol that appears at the right corner of the object. The direction of the motion
path indicated by an arrow appears.

4. To change the direction of motion, click the arrowhead and drag it in the new direction.

s aalio )
Apply o5 Jlsl
Asymmetric ool
Basic 4l
Bevel 095 A
Blink 0 S
Clockwise celu sl jie (i 8 Cga s
Collapse OM o (hed Ay
Disapereance REW R
Effect o gl
Emphasis &S b
Entrance $39,8
Free Fall 3157 D g
Glide P
Glow i
Heart Beat ol
Live Preview 0y alad
Pentagon o S =
Rotation o
Scale oole ki
Skew a8 Sl asly oo S b
Triangle Sl
Yyy

www.DataNiyaz.com




Sans o |y Effects b 55053 &y g 40 gl Sioles i sdwlin 0\Sul ay § P18 )
Add Effects (& Apply Effect (<

Properties (s Live preview (C

T i g il 2 o iy 5 Calind (K5 i el sl 31 s 1S Y
Basic (& Color Effects (4!

Exit (s Entrance (C

> ScaleTo o g ;8 Y

S 2508 5 Bl el e (]

o & S 0508 5 (B (el ki (0

B o po ke 005 Sl 4l d

ol g3ds 4yl o3lul 4 Lis > (o

3 gui gr oolizal o slam 218 5al 35 S5 4 0 Ky i 51 =F

Set Glow (o Blur (4!

Tint (s Brightness (C

$05,15 3 dvas 4y e o g )15 6 o gl 5l aiis r\.S_O

Entrance (o Emphasis (!

Exit (s Filter (C

Sl oo o gl 51 diaas oIS > Zoom out s gl 7

Motion Path (& Emphasis (<l
Filter (s Exit (C
£ b g O e (S o Goo gl e 0 sl 215 Y
Pentagon (o Glide (!
Triangle (s Rectangle(c

YYf

www.DataNiyaz.com



Sl S ia gl o LI U155 1 0 s b

SJJ)‘.) Jj)lsw)‘;wcjfd‘j bb}l}.)‘du;m.) r‘.)s_/\
Entrance (v Filter (4!

Exit (5 Color effect (C

5,00 63,6 a5l S e slas gl )

gmg&ﬁ 58 5,0 ijo}lq.e\;w)..\;.?‘Captivate)\}\rj)a_\'

55 i g o3litael B sl 31 es 518 51 a1l S (5l s sl (51 Y

..\ghéc:abj\)o}l?&.djo}oﬂ.;b«6)‘.355}&?5}’6_\0

YYO

www.DataNiyaz.com



.\:.’Sdél—é‘ ‘J“U\ JJ‘ﬁtJ‘}‘%w}ﬁ]éJ}j&!.

il i (555 50w Sy ames Jils 3l (s rL;i»o)L,.c ol S sl | ) amies s Intro G -
)\J‘S\rjo\};pj)\}\r)ég&;»u}&w}i .xﬁ&%\g)\)@bﬁo)yqua}.\;%w.:}J}e:b
.Jﬁa:\:&u&a\ymuga};)}bq‘IntrorLeJ\)‘\w 259031y Gila b & YU 51

Slgn dIntro saslivs & 5,8 bl r»c;),,.o);l:.x:m)\} Skip Intro b L 51 4s5> (Intro amies 5> ¥
rw\umael:wliwbPause;Jb-.\iLgdg:L;il.e.:.bb) Sy g dmio 3,1y 503 S G0 ol 5l
(554 pb s amiw Jdntro

25 g i 5yl 5 ol oy (o g b dalad S cazkes p a4 by 0 Olio 5 Y

b ysh Gispeh Syl 1nl a8 sbwl J3l dmies s Intro S «ig g5k ol 0555 )2 @

L;,;.am_sj\,cbl.m’..»;,.:»\.su:;g.l.«s’Yla_a\gw.lu'\otoﬁsrlsw.;ﬁmaj\,&i;&ﬁdf

Yvg

www.DataNiyaz.com



Library o3 S )8 5 (Import) b J,6 55 5,1 5 U] 45 ¢ P.QQJLG? J.q.dé

leraryL )Lg )}})\f‘f}).} LhJiLB u.); JJ‘}%}’:.S 6;)‘9”

G, sl

248 35y o5l g2 51 byl aalllas 51 g

cadl dzils 1) Psd o gy b Ol g8 sla LB 013 05 5,515 oLl 55 -

el aals ) S g sl BB el 0555 sl Ul -

claobul | sy 5 by gbadlul sl 5 -

e ol a5 1 gl glaalulsS w15 5 sl | Library b S (g o g0 -
.48 bl |, (Image Slide Show)  slas r,.]\& 5 g0

Yyv

www.DataNiyaz.com




Iy a5 )8 @

PURY

S a5l s i 15l 5 sl sl bls (IMport) s 3,1 oSul Captivate 1531,
iy gp Ll 8555 488 63150 0 il y03de S salined LT 51 il 5 o S S0 G sin 53 5 s g0
313 35 55 By e 5o Wil 5l oalinn) ISl & o g gn Ll 555 (Library) £lsulS 4 (S5 55 5 5ba
o g o Ll Gl IS Sl 5 51531054 ciliine (6o G 00 5 3150525 b Jasd 53

25ap & Sls G o35 Y F)

035 Blol gl il o Oliss cbaY SS& 5 glulis 4 0l s 4 Captivate Ity
sk 4dS L) Photoshop file 4 S Import s sz 5 «File 5 5 31 055, 4. Psd & goas b Slit g5 U
FU 5T sba¥ (VYN JSG) 55 g0 bl & (650 5o b Ol 31 uy a8 Ol | (Shift+Alt+P
S i | 6 g ool Galai 05y 5 50 a0 S Ol g3
Flattened Image 45 S IMpOrtas Cuamd 3 3 gebo3ls ikl dmies 13 5 5o (S Oy g0t b6 JS sl s 0 S
(6 gt gr 051 e 5380 SSE & oty Y poai s Layers s (o3 g 5 b 4) 48 sl
el sddoals s VELY S o e

PR————
Fraeahap Livie COmpT. & Snghe (- Mgl |
| LaiE Dacumant Sate ¥ |

1) Scpbe wtawmmalineg B 150 ge nigw

]
| Besact Photmshon Laven = Impart s o Al
| Impent i G L |

B sl |
[ T | |.ru-""'—';‘.*l"..l.r-“'._£'i....—':|-5'
B ok s | |

B Mawer baigrmed |

o | [ o | E

sy G o538 ) Py S

YYA

www.DataNiyaz.com




———————0 Library L 5 5 (Import) s b o3 5 5,15 GUl5 ¢ w23 lga Juad

T [N 5> <S50t 43 p oyip o & ks

= Image | ccessiats_ | -Gl s 0315 il Timeline
Mursa | brage_d4 | -
C A — ! s oley woses Lot | Y 2ol 4 ul5 0
T e gl el Jlael gl s, | plsds ogda Lasls i |,
L B
IEHEI ]EI QL;.«&}@:-@JM))Edltd.«s.)dj)cam‘@s;)dwlj)
Linksge: Flowar.ped [ipdaee | "

23 i) g =\ PY S

B S e bum e s i U

Captivate ,s PSD J0 sba¥ S\ fY

tas 2wl ) 5 gl 51 (S sl b el 0355 0l L
.28 B! |, From Microsoft Powerpoint 4 S Create New e | G gy 5o =)

&S ol 1, Project From MS Powerpoint M; New Project ¢ s 5 File (¢ 5 31 Y
YYa

www.DataNiyaz.com




Iy a5 )8 @

1) b ol sy o35 4 g 0 & oDl 5035 sl b (VY JSE) 5 5 0 5L S (608 o
«Onmouse Click b ;3 .3 3 oo asedo BNl Liolai o 26 (Advance Slide Cuad 55 - a8 Ol
ol Sl gl sb 4 gan ! Automatically Cdls 5 5 550 SIS Wb gam Ml Lol 1,

R IPETIE
bssls e oty o sl o sanlin LU Captivate 158005 55 Sl b s 202 00 s gl

oS Lol 5 G |y saMed tos e bl | LT oM 1 8 S5

sori Wl 5d N B Fanr- Pt Foppes P,

e i

-

P
A [T et} a8 | e
e T i, .
o) el

C«S.A‘,.:J)l.;wl«')!njjxébxl_\$_fd£2 e
—e W S —

- g g0 0315 L 2 )5 4 «Captivate

Captivate ;5 S g 5b o ol 5 Y FY)
Edit (¢ 50 33 31 0390 Sl y SIS lais ) 50wl (5, Filmstrip cand 5 bl (il s ),
(Edit Presentation 4y § ol & g s . a8 Ozl |, Edit Slide 4y S «with Microsoft Powerpoint
o a0l 53 o 50k Dlle s 51 Captivate 13105 5505 5525 S spsl b JS Sl s oSl
&S o onliul
YYe

www.DataNiyaz.com



———————0 Library L 5 5 (Import) s b o3 5 5,15 GUl5 ¢ w23 lga Juad

Ja._.mawm;aﬂz»s\)Q\ﬁé:.\;\}:@MﬁwY\eu;ﬁSaveAJ:@)LQ\ﬁﬁrl:g\)'\w

m _ Cancel (\ f_0 J&w) JQJ;)L Captivate

—_—

[NSERT DESS0E TRANSITRONS

[ Lot -

£ Rt
Faile Idiva

- e -

Captivate Jaow 3 Sy g )54 Rl =V F0 IS
Powerpoint Slide 7 > ) \f o

28 ) Powerpoint Slide 4 S Insert (¢ yre 31 ol S 4 Jlab 035, 55 S g55b L;La.\ﬂ)kw\cy sy

--W\e@ Js s alia \AQ}SOWJ&V S b ‘);239)}‘ VPP Jiu S aaed ~-’5;:§)‘J5 039

Animation Slide > ) ¥
L) Animation Slide 4 S Insert (s s 31« Ja 35, 53 Gif b SWE % e b laily S TSl
a1 ae a el 5 Glilg o Jaisy g0 BB Ol 51 oS Ol | (Ctrl+ Shift+ N il w8

~->}~3L;‘°->‘->gf~iu°}'}j.)-’d)[-",'

Video Slide 7 > ) 0
CPVC Slide s S Insert ¢ 5 31 Captivates) s , 55 s Jous Video Demo i s, LS o 55 g6l
i 08 5 0l s ol o 4l 85 gt gp a3l Lo 4 Bl 6 ks 5l Dl S L dsls s
MPA oy 5 o s b 51 e )i W 6 55 e vl 2 5 95 5 g S Ypb oSl 31 il

S 6ol gyl w4 1y sy Insert Video ay 8 Video (s st b 5l 5035 4

Sl O LY Wl 55 PSD b S U351 adheel 55 o3 S slow ) dyaa 055, St VFN (el
S ) | sut Jao Video Demo i, 4 &S 5SS adlal 53 5 Cis 5l

AR

www.DataNiyaz.com



Iy a5 )8 @

J——
S Library | '\ f_%
e ikt 45 )05 ssb 4 oS e Blol s oiy, 0 81 Gldl a8
solaza! d‘j K g wlo) 0595 &L"UL'-'S 4 o (S A.LL O
E-:n- :T:Ei-";‘l_ — - C'JL' )JJE.))}A ;w S Y SW 4;\.;&\ a))jA:Ade_wl }\ REC
o O Reckpmanin  Foder .
gﬂ'lﬂl— I:: iR 1 .(\f_?JS.;)J.,SgS\JS” Library
i mag b - .. .
e 5 ods Al 31 ol Gl el o) 3l et S L & S S
=peen e |
Etﬂ’ﬂ : ‘-‘ : "’}“@U)j["’pk.f‘i‘f“'&l"ﬁ »b@@lgml’uw}uwﬂd\m
CH WA d z .
N i gy VA 4 (Select Unused Items) 4y 8 (55, I wonlinad M Ll G (51
8 ity brese 8" 1
E:- b :: - (Delete) © 4S5 655 il sl 31 e 505 § SIS Library <l s
Smim i e b e
Sl e R ®
gty deege M 1

WelsS 2y F S
Qﬁ)b)ﬁw‘)&sﬁaj}a;wid))w‘gls ‘h“l)jj_bl):b)}j&-guld:ﬁﬂ‘uaj)lsdéd‘j
.S ol |, Export

External Library &3 55, 5 ) s0) V FF_)
4,8 IMpOIt (5 sia 15 (File (5 s 31 Koo 1355 53 03, Su A5 53 55 50 Ltl 51 oslisal 51,
555, 3 S SIS (Open Library) 4S5 g5, [Library cJb s b a8 ol |, External Library
Sy Sl o35, 5o Ll N Slpogd gl &8l o o iy 53 1053, AbulS S Ol |y s e
il Sk S o Ol oS (glods A S L aS SIS SLulS 5o s ge e
(SlideShow) ,; s p 51 slny | Y TV

Gl ol gl b 5 b o oy Oy 50 48l g3ds sl iy (Slide Show b sl s 5T 51 o

:.\.,Mr\;'d\\).\gw
YYY

www.DataNiyaz.com



———————0 Library L 5 5 (Import) s b o3 5 5,15 GUl5 ¢ w23 lga Juad

O3 LSy 0 o es S Ol |, Image Slide Show i, § New Project s 2 5o Olle 5 Sl 5w =)
.48 Ols! | Tmage Slide Show i « Project New s s ;5 File (6 s 5 Ol
bl 4l i o35 103181 gus 3181 SV 0 Ol s go ol w055 2l et 5 o Y
23 g2 0303 513NN S 53 50 2 gl 53 a8 o @l 31, 50 (605 el Jlas | OISl o Sh s oy
235035 pammaa Ly aMal p il by Sae (Display Time s s ol Oloo gz ;05 55 Y
S Sl |, aly3ds 38 Transition iy
YW 3]
.u,fo,» (Transition) ,8 \)ﬁad.gwww_g}msf

S Lol ol ey o 4 1) 2l s Kl il g o i Conlin (51, ¥
a8

&Uﬁt ‘)Shift%lssb)}ﬁ‘)}\.\)}od})«Qb}gé‘jﬁwﬁ)}rﬂ).\cu,\im‘@);;’;w‘d\j

w«ka)ydu&%‘dj)&sr&& «J‘j&dﬁuw\d‘j %‘S&SQJ}‘JJ’Td})J&“b

.Jﬁ)\)&w‘la \) Ctrl

%stWF@)j’-g&J}:-Jib)‘w;aﬁs\)g}ib‘)sru‘)\w_o

S 4 SWF &y g 4 Ll 35900 655 50 35350 yslai 51 Slide Show &G : VY 0

(s polais] baMal 4 1, dﬁb“" L;Lh);\fj 3 9 ey oMl aw 5o @\3;‘]" &&T)

YyYy

www.DataNiyaz.com



FB oS wlol gl ail o oligs ba¥ SS& 5 glulc 4 0l 4> 4 Captivate il e
S 5 &5 L) Photoshop file &8 JImport sy 5 File s 51 05, 4 Psd &y | Sl g
S Ol | (Shift+Alt+P

From Microsoft 4 § Create New Ceeud | G oo P 5 s 30b JB wlal o555 0wl sl s
Project From MS 43§ (New Project s sw ) «File sy 51 L a8 Ozl |, Powerpoint
ale ol |, Powerpoint

25 L) Powerpoint Slide 4 8 Insert (¢ s 31 Cul 31 ¢ Jb 035, 55 g0k sbadalrysgly0
- a8 Ol | (Shift+ Ctrl+ P oS 5

=5 5 %S L) Animation Slide 4, 8 Insert (g s 5| ¢ Jub 035, 0 Gif L Swf yliby Sl @
S ol 1 (Ctrl+ Shift+ N

CPVC 4§ Insert (s s 31 (Captivate o35, 3 ot Jou> Video Demo iy, b oS o 5 rrle
-l ol 1 Slide

2557 SBulS & sad Gy abb O g0 4 5 055 Hsb 4 uS LBl s e S QLS e
Library b ;o s, se e o 555 ol oad Lol o35 4 8 Ll 51 soms soliaal g1, . & i 0 3L
el s wlogn S ALLS 53 e b5 (6] s 5 ot 0l 51 0T Glm sl w03y 51 e b S S @
) B4 G 5008 SIS 8 (65 Il ool M Ll Gl (511 25 5 g0 0552 o Ll 3
S Ol

ol |, Tmage Slide Show 4, 8 New Project o sy s «Slide Show b L f”ﬂ sbul sl @

.S olss! |, Tmage Slide Show 4 % « Project New (s 5 5 File s 31 Los S

\AAS

www.DataNiyaz.com



———————0 Library L 5 5 (Import) s b o3 5 5,15 GUl5 ¢ w23 lga Juad

Learn in English

Import Photoshop files

You can import a PSD file into your Adobe Captivate project, while preserving Photoshop

features. You can select and import separate layers of the PSD file, or you can flatten selected

layers and import them as a single image.

Each imported layer is treated as a separate image within the Adobe Captivate project. In

the library, a folder with the PSD name is created and each imported layer is stored in it in

PNG format.

You can resize the imported images to the size of your Adobe Captivate project. You can

also apply all other available image—editing properties of Adobe Captivate.
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Publish projects as executable files:

You can create stand—alone, executable files of your Adobe Captivate projects. This

publishing option enables you to create a Windows executable

file (EXE) or MAC executable file (APP).

1. Select File > Publish.

2. In the Publish dialog box, select Media, and Select Type From the menu, select

Windows Executable (s.exe) or MAC Executable ( s.app).

3. Then select the output options.

s ks

Author N ft
Autoplay 55 sl
Compress 3l 0
Default O
Description a5
Expire Date Leais| .@)U
Fade o gue
Include 5 s
Playbar SAS 5 s
Position ot ga
Preferences by
Preloader 3, P e
Publish Szl
Rescale o1 i
Restore &L”)‘L.
Skin Koy
Table Of Content | ot Coams b o
Tooltip Lasl,
AR
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